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	STANDARD	OPERATING	PROCEDURE	

Title:		Human	Plasma	Assay	Validation	on	Agilent	6490.	

	 			

Version	#:		1	 Author:	UVic	GBC	Proteomics	Centre	

Date:	15/4/2016	 	
 

	

Purpose	
The	purpose	of	this	document	is	to	describe	the	characterization	of	a	set	of	assays	
by	response	curve	(reverse	curve	version)	and	repeatability.	

Scope	
This	procedure	covers	overall	preparation	and	running	of	samples	for	generating	
the	response	curve	and	repeatability	validation	samples.	
	
Responsibilities	
It	is	the	responsibility	of	person(s)	performing	this	procedure	to	be	familiar	with	
laboratory	safety	procedures.		The	interpretation	of	results	must	be	done	by	a	
person	trained	in	the	procedure	and	familiar	with	such	interpretation.			

Equipment	
• Pipettes	
• 37˚C	dry	air	incubator	
• Vortex	mixer	
• Microcentrifuge	
• Balance	
• Vacuum	manifold	
• 1L	graduated	cylinder		
• Agilent	6490	
• Skyline	software	
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Materials	
o Worthington	Trypsin-TPCK	treated	(Worthington,	LS003744)	
o Urea	(Sigma,	U0631)	
o DL-Dithiothreitol	(DTT)	(Sigma,	43815)	
o Iodoacetamide	(IAM),	(Sigma,	I1149)	
o Trizma	base	(Sigma,	T6791)	
o Sodium	Deoxycholate	(Sigma,	D6750)	
o Water,	LC-MS	grade	(Sigma,	39253)	
o Acetonitrile,	LC-MS	grade	(Sigma,	34967)	
o Methanol,	LC-Ms	grade	(Sigma,	34966)	
o Formic	Acid,	LC-MS	grade	(Sigma,	56302)	
o 1.5mL	MAXYMum	Recovery	tubes	(Corning	Axygen,	MCT-150-L-C)	
o Falcon	15mL	conical	centrifuge	tubes	(Corning,	352096)	
o Falcon	50mL	conical	centrifuge	tubes	(Corning,	352070)	
o 1.5mL	screw	cap	microtubes	(Agilent,	5188-5251)	
o Oasis	HLB	1cc	extraction	cartridge	(10mg)	(Waters,	186000383)	
o AlumaSeal	II	foil	seals	(Fisher,	361006023)	
o 300µL	PP	screw	cap	vials	(Canadian	Life	Sciences,	V0309P-1232)	
o Human	plasma	
o Heavy	stable	isotope-labeled	standards	(SIS)	and	matched	light	versions	

were	synthesized	and	purified	by	HPLC.		Heavy	peptides	incorporated	a	fully	
atom	labeled	13C	and	15N	isotope	at	the	C-terminal	lysine	(K)	or	arginine	
(R)	position	of	each	(tryptic)	peptide,	resulting	in	a	mass	shift	of	+8	or	+10	
Da,	respectively.	Peptides	were	quantified	by	amino	acid	analysis	and	
aliquots	were	stored	in	30%	acetonitrile,	0.1%	formic	acid	at	-80˚C	until	use.	

Solutions 
• 1M	Tris,	pH	8.0.		May	be	made	in	advance	and	stored	at	4˚C:	

o Add	12.12g	solid	Trizma	base	to	a	250mL	beaker.	
o Add	50mL	LC-MS	water	and	mix	until	dissolved.	
o Adjust	pH	to	8.0	with	concentrated	HCl	(12M).	
o Transfer	solution	to	100mL	graduated	cylinder	and	bring	volume	to	100mL	

with	LC-MS	water.	
• 9M	Urea,	300mM	Tris,	pH	8.0.	Must	be	made	fresh	daily:	

o Add	2.7g	Urea	to	a	50mL	Falcon	tube.	
o Add	1.25mL	LC-MS	water	and	1.25mL	1M	Tris,	pH	8.0	and	mix	until	

dissolved.	
o Measure	pH	and	bring	to	8.0	if	necessary.	
o Bring	volume	to	5mL	with	LC-MS	water.	
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• 9M	Urea,	300mM	Tris,	pH	8.0,	20mM	DTT.		Must	be	made	fresh	daily:	
o Dissolve	38.5mg	DTT	in	500µL	9M	Urea,	300mM	Tris,	pH	8.0	solution	

(above).	
o Transfer	125µL	to15mL	Falcon	tube	and	add	3.0mL	9M	Urea,	300mM	Tris,	

pH	8.0m	20mM	DTT	(above).	
o Mix	well.		

• 500mM	Iodoacetamide	(IAM).		Prepare	immediately	before	use	and	keep	out	of	
light:	

o Dissolve	56mg	IAM	in	605µL	LC-MS	water.	
o Mix	well.	

• 100mM	Tris,	pH	8.0:	
o 1	part	1M	Tris,	pH	8.0	(above).	
o 9	parts	LC-MS	water.	

• 1mg/mL	Worthington	TPCK-	Trypsin.		Prepare	immediately	before	use:	
o Dissolve	4mg	trypsin	in	4mL	LC-MS	water.	

• 6.1	%	Formic	Acid:	
o Add	305µL	Formic	acid	to	4.695mL	LC-MS	water.	

• 1%(w/v)	Sodium	Deoxycholate	(NaDOC):	
o Add	1g	NaDOC	to	100mL	LC-MS	water.	

• 50%	Acetonitrile,	0.1%	Formic	Acid:	
o Add	500µL	Acetonitrile	to	500µL	LC-MS	water.	
o Add	1µL	Formic	Acid.	

• 30%	Acetonitrile,	0.1%	Formic	Acid:	
o Add	3mL	Acetonitrile	to	7mL	LC-MS	water.	
o Add	10µL	Formic	Acid.	

• 0.1%	Formic	Acid:	
o Add	10µL	Formic	Acid	to	9990µL	LC-MS	water.		

Procedure	
Preparation	of	1%	NaDOC-coated	tubes	and	tips	
1. Tubes:	

a. Add	500µL	1%	NaDOC	to	1.5mL	MAXYMum	Recovery	tubes	and	vortex	to	
coat.	

b. To	wash,	add	500µL	LC-MS	water,	and	vortex.	Repeat	3X	discarding	water	
between	washes.	

c. Lyophilize	to	dryness.	
2. Tips:	

a. Aspirate/dispense	maximum	tip	volume	of	1%	NaDOC	3X	using	
multichannel	pipette.	

b. Wash	with	maximum	tip	volume	of	LC-MS	water.	Repeat	3X	discarding	
water	between	washes.	

c. Lyophilize	to	dryness.	
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Std	L								
10pmol/uL

Std	K											
1pmol/uL

Std	J											
100fmol/uL

Std	I															
50fmol/uL

Std	H															
10fmol/uL

Std	G															
5fmol/uL

Std	F															
1fmol/uL

Std	E																	
0.5fmol/uL

Std	D															
100amol/uL

Std	C															
50amol/uL

Std	B															
25amol/uL

Std	A															
12.5amol/uL

Std	L stock 10uL
Std	K 10uL
Std	J 25uL
Std	I 14uL
Std	H 25uL
Std	G 14uL
Std	F 25uL
Std	E 14uL
Std	D 25uL
Std	C 25uL
Std	B 25uL

0.1%FA 90 90 25 56 25 56 25 56 25 25 25
Dilution 1 10 10 2 5 2 5 2 5 2 2 2

Matrix	Digestion	(Experiment	1	&	2)	
	

Preparation	of	Samples	
3. Prepare	12	replicates	(5	for	Assay	Validation	Experiment	1	and	7	for	Assay	

Validation	Experiment	2).	
4. Dilute	human	plasma	to	14µg/µL	with	100mM	Tris,	pH	8.0	(estimate	70	µg/µL	

human	plasma	protein	concentration).		
5. Add	50µL	9M	Urea,	300mM	Tris,	pH	8.0,	20mM	DTT	to	a	1.5mL	MAXYMum	

Recovery	tube.	
6. Add	25µL	diluted	plasma.	
7. Denature	and	reduce	at	37˚C	for	30min.	
8. Add	6.5µL	500mM	IAM.	
9. Alkylate	at	room	temperature	for	30min	in	the	dark.	
10. Add	737µL	100mM	Tris,	pH	8.0	to	decrease	urea	concentration	to	0.55M.	
11. Add	17.5µL	of	1µg/µL	Worthington	Trypsin	(20:1	substrate:enzyme	ratio).	
12. Digest	at	37˚C	for	18hrs.	
13. Add	164μL	of	6.1%	Formic	Acid	to	quench	digestion.	
14. Total	volume	post	digest	=	1000µL,	plasma	protein	concentration	=	0.35µg/µL	
15. The	digest	replicates	prepared	for	Experiment	2	can	be	stored	at	-80˚C	until	

required.	

	
Experiment	1-	Response	Curves	

	
Heavy	SIS	spike	preparation	
16. Prepare	a	10pmol/µL	equimolar	mix	of	SIS	peptides	with	0.1%	Formic	Acid.		
17. Prepare	serially	diluted	SIS	peptide	mix	using	1%	NaDOC-coated	tubes	and	tips	

(table	below).	
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Light	spike	preparation	
18. Prepare	a	10pmol/µL	equimolar	mix	of	Light	peptides	in	0.1%	Formic	Acid.		
19. Dilute	stock	Light	peptide	mix	to	100fmol/µL	in	0.1%	Formic	Acid	using	1%	NaDOC-

coated	tubes	and	tips.	

Standard	Curve	preparation	
20. To	12	x	1.5mL	uncoated	MAXYMum	Recovery	tubes	add:	

a. 220µL	plasma	digest	
b. 15.4µL	of	100fmol/µL	Light	peptide	mix	
c. 15.4µL	of	level	specific		SIS	peptide	mix	

Double	blank	preparation	
21. To	an	uncoated	MAXYMum	Recovery	tube	add:	

a. 660µL	plasma	digest	
b. 92.4	µL	0.1%	Formic	Acid	

SIS+Matrix	blank	preparation	(to	estimate	endogenous	concentration)	
22. To	an	uncoated	1.5mL	MAXYMum	Recovery	tube	add:	

a. 220µL	plasma	digest	
b. 15.4µL	of	0.1%	Formic	Acid	
c. 15.4µL	of	100fmol/µL		SIS	peptide	mix	

Desalting	and	Concentrating	Samples	Offline	by	Solid	Phase	Extraction	
23. Set	the	negative	pressure	system	manifold	to	-25	kPa.	
24. Condition	cartridge	with	1mL	of	Methanol.	
25. Equilibrate	cartridge	with	1mL	of	0.1%	Formic	Acid.	
26. Add	sample	to	cartridge:	

a. Response	curve	&	SIS+Matrix	blank:	772µL	0.1%	Formic	Acid	then	228µL	
sample.	

b. Double	blank:	316µL	0.1%	Formic	Acid	then	684µL	sample.	
27. Wash	cartridge	with	3	x	1mL	of	100%	LC-MS	water.	
28. Elute	peptides	with	300uL	50%	Acetonitrile,	0.1%	Formic	Acid	into	a	1.5mL	

MAXYMum	Recovery	tube.	
29. Freeze	eluates	using	liquid	nitrogen,	and	poke	a	hole	in	the	lid.		
30. Lyophilize	samples	to	dryness	overnight.	
31. Seal	using	AlumaSeal	II	foil.	Samples	can	be	stored	lyophilized	at	-80°C	until	ready	

for	SRM	analysis.	

Reconstituting	Samples	(To	be	performed	just	prior	to	LC/SRM-MS	
analysis)	
32. Reconstitute	dried	and	desalted	digests	with:	

a. 	Std	Curve	&	SIS+Matrix	blank:	70µL	of	0.1%	Formic	Acid	to	each	sample	
(1μg/μL	plasma	digest).	

b. Double	blank:		210µL	of	0.1%	Formic	Acid	(1μg/μL	plasma	digest).	
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L1000X			
100pmol/µL

500XHigh			
50pmol/µL

50XMedium			
5pmol/µL

3XLow			
0.3pmol/µL

1000X stock 20
500XHigh 7
50XMedium 12
3XLow

0.1%FA 20 63 188
Dilution 1 2 10 16.7

33. Vortex	sample,	spin	down,	and	transfer	to	an	autosampler	vial	for	LC/SRM-MS	
analysis.	

	
Experiment	2-	Mini-Validation	of	Repeatability	

	
Heavy	SIS	spike	preparation	
1. Prepare	a	SIS	mix	1000X	the	Lowest	point	on	curve	(LPOC)	of	each	peptide	in	0.1%	

Formic	Acid,	calculated	from	Experiment	1	data.	
2. Prepare	serially	diluted	SIS	peptide	mix	in	0.1%	Formic	Acid	using	1%	NaDOC-

coated	tubes	and	tips	:	
a. Low	SIS	spike:		3X	LPOC	calculated	from	Experiment	1	data	(referred	to	as	

3XLow).	
b. Medium	SIS	spike:		50X	LPOC	calculated	from	Experiment	1	data	(referred	to	

as	50XMedium).	
c. High	SIS	spike:		500X	LPOC	calculated	from	Experiment	1	data	(referred	to	

as	500XHigh).	

	
	
	
	
	
	

	
	
	
Standard	Curve	preparation	
3. On	each	of	5	different	calendar	days:	

a. To	3	x	1.5mL	uncoated	MAXYMum	Recovery	tubes	add:	
i. 100µL	plasma	digest	
ii. 7µL	of	100fmol/µL	Light	peptide	mix	(prepared	in	Experiment	1)	
iii. 7µL	of	3XLow		SIS	peptide	mix	

b. To	3	x	1.5mL	uncoated	MAXYMum	Recovery	tubes	add:	
i. 100µL	plasma	digest	
ii. 7µL	of	100fmol/µL	Light	peptide	mix	(prepared	in	Experiment	1)	
iii. 7µL	of	50XMedium		SIS	peptide	mix	

c. To	3	x	1.5mL	uncoated	MAXYMum	Recovery	tubes	add:	
i. 100µL	plasma	digest	
ii. 7µL	of	100fmol/µL	Light	peptide	mix	(prepared	in	Experiment	1)	
iii. 7µL	of	500XHigh	SIS	peptide	mix	
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Double	blank	preparation	
36. On	each	of	5	different	calendar	days:	

a. To	an	uncoated	1.5mL	MAXYMum	Recovery	tube	add:	
i. 300µL	plasma	digest	
ii. 42µL	of	0.1%	Formic	Acid	

Desalting	and	Concentrating	Samples	Offline	by	Solid	Phase	Extraction		
37. Set	the	negative	pressure	system	manifold	to	-25	kPa.	
38. Condition	cartridge	with	1mL	of	Methanol.	
39. Equilibrate	cartridge	with	1mL	of	0.1%	Formic	Acid.	
40. Add	sample	to	cartridge:	

a. Response	curve:	912µL	0.1%	Formic	Acid	then	88µL	sample.	
b. Double	blank:		674µL	0.1%	Formic	Acid	then	326µL	sample.	

41. Wash	cartridge	with	3	x	1mL	of	100%	LC-MS	water.	
42. Elute	peptides	with	300uL	50%	Acetonitrile,	0.1%	Formic	Acid	into	a	1.5mL	

MAXYMum	Recovery	tube.	
43. Freeze	eluates	using	liquid	nitrogen,	and	poke	a	hole	in	the	lid.		
44. Lyophilize	samples	to	dryness	overnight.	
45. Seal	using	AlumaSeal	II	foil.	Samples	can	be	stored	lyophilized	at	-80°C	until	ready	

for	SRM	analysis.	

Reconstituting	Samples	(To	be	performed	just	prior	to	LC/SRM-MS	
analysis)	
46. Reconstitute	dried	and	desalted	spiked	digests	with:	

a. Response	curve:	27µL	of	0.1%	Formic	Acid	to	each	sample	(1μg/μL	plasma	
digest).	

b. Double	blanks:		100µL	of	0.1%	Formic	Acid	(1μg/μL	plasma	digest).	
47. Vortex	sample,	spin	down,	and	transfer	to	an	autosampler	vial	for	LC/SRM-MS	

analysis.	

LC	and	MS	Setup	(Experiment	1	&	2)	
	
LC	Setup:	
1. Top	up	both	A	and	B	buffers	being	careful	to	keep	the	solvent	delivery	filters	

submerged.	
2. Purge	and	flush	pumps	at	50%	A	for	5min	and	10min	respectively	if	LC	has	not	been	

recently	used.	
3. Bring	column	to	start	conditions	and	confirm	that	pressure	is	between	400-600bar.	
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LC	Parameters:	
4. Flowrate:		0.4mL/min	
5. Column	temp:	50˚C	
6. Gradient:	

	

	
	
	
	
	
	
	
	
	
	

	
Agilent	6490	Setup:	
7. Perform	checktune	

Agilent	6490	SRM	Parameters:	
8. Transitions:	

a. Monitor	5	transitions	for	each	light	and	SIS	peptide.	
b. MS1	and	MS2	Resolution:	unit	
c. Fragmentor:	380V	
d. Cell	Accelerator	Voltage:	5	

9. Dynamic	MRM	Parameters:	
a. Cycle	time:	850msec	
b. Min	Dwell:	≥10msec	

10. Source	parameters:	
a. Gas	Temp:	150˚C	
b. Gas	flow:	15L/min	
c. Nebulizer:	30psi	
d. Sheath	Gas	Temp:		250˚C	
e. Sheath	Gas	Flow:		11L/min	
f. Positive	Capillary:	3500V	
g. Nozzle	Voltage:	300V	

Naming	of	Data	Files:	
11. Experiment	1:	

a. Curve	levels	should	be	named	StdA	to	StdL,	with	StdA	being	the	least	
concentrated	sample	and	StdL	being	the	most	concentrated	sample.	StdA	can	
also	be	the	double	blank	sample	if	one	is	being	used.	

b. Blanks	should	be	named	MatrixBlank_01	

Time	(min)	 %	Buffer	A		 %	Buffer	B	

0	 98	 2	

2	 93	 7	

50	 70	 30	

53	 55	 45	

53.5	 20	 80	

55.5	 20	 80	

56	 98	 2	

+	4min	post	time	
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c. Example:		Date_Project_AssayVal_Exp1_StdA_01	
12. Experiment	2:	

a. Curve	levels	should	be	named	3XLow,	50XMedium	and	500XHigh	
b. Sample	prep	replicates	should	be	named	R01	to	R03	
c. Injections	should	be	dated	
d. Example:		Date_Project_AssayVal_Exp2_3XLow_R01	

Sample	injection:	
13. Injection	volume	will	be	10µL	for	all	samples.	
14. Experiment	1:	

a. A	double	blank	will	be	injected	5	x	prior	to	the	curves	to	estimate	noise.	
b. Inject	samples	in	singlicate	from	low	concentration	to	high	concentration.	
c. Three	blanks	will	be	injected	between	curves	for	carryover.	

15. Experiment	2:	
a. Inject	samples	from	low	to	high	concentration.	
b. Each	of	the	3	sample	prep	replicates	for	the	3XLow,	50XMedium	and	

500XHigh	samples	will	be	injected	1x	(for	a	total	of	3	injections	per	level)	on	
each	of	5	different	calendar	days.			

c. A	double	blank	will	be	injected	between	the	500XHigh	and	3XLow	samples	
for	carryover.	

Data	Analysis	(Experiment	1	&	2)	
	
Quantitation	of	Data	using	Skyline:	
1. Create	a	new	Skyline	method	
2. Set	Internal	Standard	to	light		(Settings>Peptide	Setting>Modifications)	
3. Import	proteins,	peptide	sequences,	and		transitions	from	Excel	
4. Add	protein	accession	to	protein	note	(View>Document	Grid>	Proteins)	
5. Save	as……				validation	curve.sky	
6. Change	Internal	Standard	to	Heavy	(Settings>Peptide	Setting>Modifications)	
7. Save	as….		single	point.sky	
8. Import	single	point	files	
9. Inspect	and	correct	integration	
10. Export	CSV	
11. Take	PAR	X200	to	calculate	amount	in	single	point	measurement	
12. Save	an	close	single	point	skyline	file	
13. Open			…….validation	curve.sky	file	
14. Import	data	files	(File>Import>Result)	
15. Set	Skyline	to	integrate	all	measured	transitions	(Settings>Integrate	All)	
16. Add	Sample	Type	and	IS	(Single	point	method)	concentration	(View>Document	

Grid>Replicates)	
17. Inspect	and	correct	integration	if	necessary	
18. Save	and	upload	to	Panorama	
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Referenced	Documents	
	
	


